—NAN(=ng

FABRICA ARGENTINA DE NANO SENSORES IOT

MANUAL EXTENDIDO

MODULOS EDUCATIVOS
KIT MAKER 10T

Yy X R D 0§ ¢ & ®

Lea detenidamente esta guia antes de usar el producto y
consérvelo para futuras consultas.




02

03
05

07

03
10

"

12
13

13

Caracteristicas técnicas
Modulo Base
Modulo Interfaz

Mddulo Alimentacion

Ensambles

Conexiones

Recomendaciones

Programacion

Diagrama de Pines

Entorno de Programacion



KIT MAKER 10T
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—O0 Mdédulo BASE

El M&édulo Base esta integrado por el microcontrolador
ESP32. Cuenta con conexion WiFiy Bluetooth, 20
entradas/salidas digitales (de los cuales, 10 se pueden utilizar
como entradas analdgicas).

Especificaciones Técnicas:

Microcontrolador ESP32

Reloj 240MHz

Conectividad WiFi (802.11 b/g/n) Bluetooth v4.2
Alcance WiFi 30m interiores - 90m aire libre

Voltaje de Operaciones 3.3V

fig.l
Voltaje de Alimentacién | 5V d
Peso: 55 gr

Pines E/S Digitales 20 Alto: 70 mm
Ancho: 50mm

Entradas Analogicas 10
Conectores RJ11 3
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Referencias s>

ECRERR BB

ESP32: Es el cerebro del Médulo Base.

Selector de Pines V_BAT/A36: Con un jumper puede seleccionar entre habilitar
el Pin V_BAT o el Pin A36.

Pin 5V: Salida 5 voltios.
Pin 3.3V: Salida 3.3 voltios.
Pin GND: GND.

Pin V_BAT: Se utiliza para medir la tension de una bateria.

Recordatorio: para habilitar este Pin debe hacerlo con un jumper
en el selector de Pines V_BAT/A36.

Micro USB: Sirve para alimentar y cargar los programas al Mddulo Base,
y para la comunicacion serial con la computadora.

LEDs TX y RX: Estos LEDs Indican cuando se realiza una comunicacion entre
la Placa Base y la PC. Parpadean rapidamente cuando se carga un programa,
o se establece una comunicacion serie.

Boton RESET: Reinicia la Placa Base.

BUS I2C: Protocolo sincrono utilizando 2 cables, uno para el reloj (SCL)
y otro para el dato (SDA).

Conector RJ11 I12C: Conecta sensores y actuadores por el protocolo 12C
mediante cables con ficha RJ11 para facilitar su conexion.

Conector RJ11 Digital: Conecta sensores y actuadores como pines digitales
mediante cables con ficha RJ11 para facilitar su conexion.

Conector RJ11 Analogico: Conecta sensores y actuadores como pines
analogicos mediante cables con ficha RJ11 para su conexion.

Pines TX y RX: Pines para la recepcién (RX) y transmision (TX) de datos TTL via serie.

Pines Digitales: Se pueden utilizar como entrada/salida en donde el usuario
lee y escribe solo dos estados ldgicos.

Pines Analogicos: Se pueden utilizar como entrada/salida en donde el usuario
lee y escribe valores de tension entre 0 y 5 Voltios.
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—O0 Mddulo INTERFAZ

El Médulo Interfaz permite la interaccion entre el Usuario y el

Modulo Base.

El mismo, presenta componentes que facilitan la informacion
a través de luces LED, sonido y su pantalla integrada.

Especificaciones Técnicas:

OLED 128x32

Monocromaticos

Pulsadores

Buzzer

Sensores:
Temperatura DS18b20
Luz LDR
Shock TILT

Puertos Bus [2C

Peso: 60 gr
Alto: 70 mm
Ancho: 50 mm
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Referencias g«

OLED 128x32: Permite visualizar textos y graficos.

LEDs Inteligentes WS2812b: Tira de LEDs RGB
(Rojo, Verde y Azul) permite combinar colores para producir
otros nuevos.

Pulsadores: Controla el paso de la corriente eléctrica.

LEDs de Color: Emiten una luz de color rojo, verde
y amarillo.

Buzzer: Zumbador el cual convierte una senal eléctrica
en una onda de sonido

Sensor de Temperatura: Realiza mediciones de
temperatura ambiente.

Sensor de Luz LDR: Realiza mediciones de intensidad de luz.

Sensor de Shock TILT: Define la posicidn del sensor.

Bus 12C: Protocolo sincrono que utiliza 2 cables, uno para
el reloj (SCL) y otro para el dato (SDA).
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——0 Médulo ALIMENTACION

El Modulo Alimentacion funciona como bateria para el Kit Maker I0T .
Posee conexion para cargarse mediante paneles solares o un
cargador USB de 5V.

Especificaciones Técnicas:

Soporte para baterias Li-lon 14500 3.7V

Conectores:
Micro-USB 5V

--------------------------------------------------------------- Peso: 90 gr
JST para paneles solares Alto: 70 mm

Ancho: 50 mm

Interruptor Encendido/Apagado
LED indicadores

® ENERGIA V1.3

Frente
a.. 1 1
@
2
- .-'_'i
&
&
(8]
o ] |
= - = 0
—=AN=iE- - |
HECHO EN MISIOMNES f
L]}
5 3

- FCRARAGA
= usB
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Referenciasfigsy

n LED Charge/Carga: Indica la carga completa.
Cargando: LED rojo o amarillo encendido.
Carga Finalizada: LED azul o verde encendido.

LED Standby: Indica que el Médulo Alimentacion estd encendido.
Conector USB Carga: SOLO para cargar las baterias.

Conector JST: Permite conectar paneles solares de 6V.

Conector USB 5V: Sirve para alimentar todos los Médulos.

Dorso

(1]
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il
[1]
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il
il
1]
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AAo2 131aS

ﬂ Soporte bateria: Contiene las baterias Li-lon 14500 3.7V
Interruptor: Enciende o apaga el médulo de alimentacion.

n Bateria: Pila Li-lon 14500 3.7V

IMPORTANTE: Las baterias deben estar correctamente colocadas, caso contrario
pueden ocasionarse dafos al equipo.
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Conexiones




——O0 Ensambles

1- Acoplar el Médulo Interfaz al Médulo Base conectando la tira de pines machos
con la tira de pines hembra.

2~ Verificar que el Médulo Alimentacidn se encuentre apagado.
5~ Corroborar que las baterias estén correctamente colocadas.

4.~ Acoplar el Médulo Alimentacién por debajo del Médulo Base.

5- Presionarel interruptor para encender el dispositivo.
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—©O  Consideraciones para la Carga

= Para aumentar la autonomia, utilizar las dos baterias.

- Es necesario un cable Micro USB y un transformador 5V/1A (un cargador de celular).

- Conectar un sélo puerto Micro USB a la vez.

- Lafinalizacién de la carga es indicada en el LED Charge/Carga (luz azul o verde).
- Realizar la conexién con el Interruptor apagado.

- Utilizar paneles solares de corriente mayor a 200mA.

- La autonomia de las baterias dependera de su uso.

A Los paneles solares se adquieren por separado.

1"
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—0 01 Diagrama de Pines

ECHO EN HISIONES .°

fig.8 - Mdédulo Base

Cada PIN contiene un numero por el cual podemos identificar
y llamarlo dentro del cddigo.

—o0 02 Entorno de Programacion

Para instalar la placa ESP32 en tu Arduino IDE, sigue las siguientes instrucciones:

A) Instalacién del complemento ESP32 en Arduino IDE

@' ESP32_data_logging | Arduing 1.8
A.l En tu IDE de Arduino, ve a File Edit Sketch Tools Help

File> Preferences e curteh
Open... Ctrl+0
Open Recent >
Sketchbook ¥
Examples ¥
Close Ctrl+W
Save Ctrl+5
Save As... Ctrl+Shift+5

Page Setup  Ctrl+Shift+P
Print Ctrl+P

I Preferences  Ctrl+Comma I

Quit Ctrl+Q




A.2 Ingrese lo siguiente en el campo "URL adicionales del administrador de la junta":

https://raw.githubusercontent.com/espressif/arduino-esp32/gh-
pages/package_esp32_index.json

Luego, haga clic en el botdn "Aceptar":

m
m
m
m

Settings  MNetwork

Sketchbook location:

C:\Wsers\sarin\Documents\Arduino

Editor language: System Default « | (requires restart of Arduino)
Editor font size: 17

Interface scale: @ sutomatic | 100 7 %  (requires restart of Arduino)

Theme: Default theme - | (requires restart of Arduino)

Show verbose output during: || compilation || upload

Compiler warnings: Mone -~

8 Display line numbers [ Enable Code Folding

B verify code after upload [] Use external editar

B Check for updates on startup B Save when verifying or uploading

[ Use accessibility features

| Additional Boards Manager URJ.s:I https: /fraw.githubusercontent.com/espressif/arduino-esp32/gh-pages package_esp32_index.jsan, htt q

More preferences can be edited directly in the file
C:\Users\sarin\AppDataLocal\Arduino 15\preferences. txt

(edit only when Arduino is not running)

OK

Nota: si ya tiene la URL de los tableros ESP8266, puede separar las URL con una coma
como sigue:

https://raw.githubusercontent.com/espressif/arduino-esp32/gh-
pages/package esp32 index.json,
http://arduino.esp8266.com/stable/package_esp8266com_index.json

A.3 Abra el Administrador de tableros. Ir a Tools > Board > Boards Manager...

% Code_Test | Arduino 1.8.5 - a ¥
File Edit Sketcl'l ToolsIHelp
Auto Format Ctrl+T
Archive Sketch
Code_Test Fix Encoding & Reload
-------- Serial Monitor Ctrl+Shift+ M I
Boards Manager...
fu° San Serial Plotter Ctrl+Shift+L - -
i Arduino AVR Boards
Smplet WiFi101 Firmware Updater Arduine Yin
T e e T e et I ®  Arduino/Genuine Uno
p Arduine Duemilanove or Diecimila
ort
// Load 1 Get Board Info Arduino Nano
include Arduino/Genuine Mega or Mega 2560

Programmer: "AVRISP mkll" Arduino Mega ADK

Arduino Leonardo

Arduino Leonardo ETH

Burn Bootloader

$include <OneWire.h>

Browse

Cancel
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A.4 Busque ESP32 y presione el botdn de instalacién para "ESP32 by Espressif Systems":

@' Boards Manager

e i

esp32 by Espressif Systems
Boards included in this package:
ESP3Z2 Dev Maodule, WEMOS LoLin22.
More info

Ll alekeee = (3/3). Downloaded 30,228kb of 125,713kh.

A.5 Eso es todo. Debe instalarse después de unos segundos.

@' Boards Manager

Type |al w | |esp32

esp32 by Espressif Systems version 1.0.2 INSTALLED
Boards included in this package:

ESP3Z Dev Module, WEMOS LoLin3Z2.

Mare infa

Select version Install Remove

Close




B) Prueba de la instalacién

Conecte la placa ESP32 a su computadora. Con su Arduino IDE abierto, siga estos pasos:

B.1 Selecciona tu Tablero en el menu Tools > Board (en mi caso es el NodeMCU-325).

E% sketch_decl2a | Arduino 1.8.5
File Edit Sketch Tools Help

sketch_dec1 2

1
2
3

vold sé

[/ p

19
et

L

void 1
/! p

)]

o |

L o
oyt

Auto Format Ctrl+T
Archive Sketch

Fix Encoding & Reload

Serial Maonitor Ctrl+ Shift+M
Serial Plotter Ctrl+Shift+L n

WiFi101 Firmware Updater

once.

(]

Board: NodeMCU-32S
Flash Frequency: "80MHz"
Upload Speed: "921600"

w

st

[

Core Debug Level: "Mone"
Port: "COM4"
Get Board Info

[

F
Adafruit ESP32 Feather
DOIT ESP32 DEVKIT V1
MH ET LIVE ESP32DevKIT
MH ET LIVE ESP32Minikit
ESP32vn loT Uno

NodeMCU-32S

Programmer: "AVRISP mkll" ;

Burn Bootloader

OLIMEX ESP32-EVE
OLIMEX ESP32-GATEWAY
ThaiEasyElec's ESPino32

B.2 Seleccione el puerto (si no ve el puerto COM en su IDE de Arduino, debe instalar el
Controladores CP210x USB a UART Bridge VCP)

File Edit Skd@ch Tools Help

Auto Format Ctrl+T

Archive Sketch
Blink_sketch Fix Encoding & Reload
Tl Serial Monitor Ctrl+Shift+ M
) Serial Plotter Ctrl+Shift+L
3| */ WiFi101 Firmware Updater
4 Board: "DOIT ESP32 DEVKIT V1" >
54 le Flash Frequency: "80MHz" >
- Upload Speed: "921600" >
6 const| et
.
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B.3 Abra el siguiente ejemplo bajo File > Examples > WiFi (ESP32) > WiFiScan

9 sketch_dec12a | Arduine 1.8.5
File Edit Sketch Tools Help

New Ctrl+N

Open... Ctrl+ O

Open Recent »

Sketchbook »

Examples : & nce:

Close Ctrl+W s 2

Save CrlsS ESP32 BLE Arduino >

SaveAs..  Ctr+ShiftsS ESPmDNS ’
HTTPClient ¥

Page Setup  Ctrl+Shift+P Preferences >

Print Ctrl+P SD(esp32) ,peatedly:

Preferences  Ctrl+ Comma SP_MMC ’
SimpleBLE >

Cuit Cirl+Q SPIFFS >
Update >
WiFi : ETH_LAME720
WiFiClientSecure ETH_TLK110
Examples from Custom Libraries LR
Adafruit ILI9341 WiFiBlueToothSwitch
Adafruit NeoPixel WiFiClient
Adafruit 5501306 WiFiClientBasic
Arduinolson WiFiClientEvents
DallasTemperature WiFiClientStaticlP
DHT sensor library WiFilPvG
Embedis WiFiMulti
ESP Async UDP | wiiscan |
ESP Async WebServer i WiFiSmartConfig

B.4 Se abre un nuevo boceto en su IDE de Arduino:
&% WiFiScan | Arduino 1.8.5 — O *®

File Edit Sketch Tools Help

WiFiScan

2 w
3 *
4 = to include
& #include "WiFi.h"
8 void setup/()
9 {
10 Serial .begin(115200);
11
12 // Set WiFi to station mode and disconnect from an AP if it was previousl:
13 WiFi.mode (WIFI_STR);
14 WiFi.disconnect ();
15 delay (100);
16
17 Serial.println("Setup done");
18}
1%
20 void loop () he
< >
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B.5 Presione el botén Cargar en el IDE de Arduino. Espere unos segundos mientras el codigo se compila 'y

carga en su tablero.

B.6 Si todo salid como se esperaba, deberia ver el mensaje "Carga finalizada". mensaje.

DOIT ESP32 DEWKIT W1, BOMH=z, 821600, None on COM4

B.7 Abra Arduino IDE Serial Monitor a una velocidad de transmision de 115200:

B.8 Presione el botdn Habilitar a bordo ESP32 y deberia ver las redes disponibles cerca
tu ESP32:

€5 com4 - o X

| Send

scan done

2 networks found

1: MEO-GZ0B4B (—-49%)*
2: MEO-WiFi (-50)

scan start

scan done

2 networks found

1: MEO-620B4B (-48)*
2: MEO-WiFi (-48)

W

Autoscroll Both ML &CR. « | | 115200 baud « Clear output

18



C) Declaracion de Variables

Para utilizar cada componente del Mddulo de Interfaz es necesario declarar, en nuestro entorno
para programar, el nimero de pin correspondiente.

C.1 Nombre del componente y nimero de pin _

correspondiente: #DEFINE LEDS_WS 27
#DEFINE BOTON_IZQ 13

Componentes N° de PIN #DEFINE BOTON_ENT 15
#DEFINE BOTON_DER 23
LEDs WS528128B 27 #DEFINE LED1 32
Botdn izquierdo 13 #DEFINE LED2 33
- #DEFINE LED3 25
Botdn Enter 15

#DEFINE BUZZER 14

Botdn derecho 23 #DEFINE S_TEMP 19
#DEFINE S_LDR 39

LED 1 32 #DEFINE S_TILT 26
LED 2 33 setup(){
LED 3 25 ’
loop(){
Buzzer 14 }
Sensor de temperatura 19
Sensor de luz LRD 39
Sensor de shock TILT 26
D) IDE Code

El cddigo IDE se compone de varias partes:

1) Verificar 3) Nuevo 5) Guardar 7) Editor
2) Cargar 4) Abrir 6) Monitor Serial 8) Notificaciones

D.1 Para hacer tu primer programa debes: digitar el siguiente cédigo como en la imagen.

1 2 345 6
setup(){
Serial.begin(9600);
7 delay(5000);
Serial.println(“Hola Mundo!”);
}
loop(){
L }
8
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D.2 Cargue el cédigo en el Mdédulo. Para ello, debe hacer clic en el botdn de carga y esperar unos
segundos para que se cargue el cddigo.

D.3 Cuando el cédigo esté completamente cargado, el mensaje Cargado se mostrara en la barra de estac
D.4 Reinicie la placa presionando el botdn RESET y haciendo clic en el icono del monitor en serie.

D.5 Se abrird una ventana con el siguiente mensaje:

- establecer este
valor en 9600
baudios.

*Recuerde
© com4
|

Send

Hi World;

[V]Autoscroll [] Show Timestamp [New line _v| [9600 baudiolv] [Clear output |

iTerminado!
Ya puedes empezar a programar tu Médulo FANIOT
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E) Descarga, Instalacion y Configuraciéon del Entorno
Programacion de bloques

El entorno de programacién de bloques le permite programar instrucciones para su modulo, por lo que
practico y visual. Permite al alumno abordar la programacion desde una usabilidad amigable en

gue integra conceptos de robdtica educativa con IOT.

E.1 Para utilizar el Entorno de Programacion de Bloques debes descargarlo desde:
https://faniot.com.ar/descarga/FAN-BLOCK.exe

E.2 Ejecute el instalador del programa vy siga los pasos de instalacion.

E.3 Una vezinstalado el entorno de programacion de bloques, debe inicializarlo.
Haga clic en "Administrador de la Junta".

Board Manager

E.4 Busque en Instalado la opcién "Generic ESP32 WROOM",
haga clic en "Cambiar tablero" y confirme.

Current board: Generic ESP32 WROOM Q ESP32 X © :

Installed Q
Generic ESP32 WROOM

CHANGE BOARD CLOSE

21



F) Instalar python

F.1 Instalar python (ultima versidn) desde https://www.python.org/downloads/

< O & pythonorgidownioads/

Python

e I

Aboul Downloads Documentation Communily Success Slories News Evenls

Download the latest version for Windows

Downilisad Python 3.11.2

Loaking ror Fyth aaierent 057 Python for Wins

spment versions of Python?

Active Python Releases

or more Informatlon visit the Python Developer's Gulde.

Python version Mnintenance status First refeased End of support Releaze schedule
311 gl 0721074 I037-10 PR &5

.10 ouglix 2021-10-04 202E-10 El

3.0 Uity J0E0-10-05 02510 E

3.8 sacurtry iaioda 3074-10 PEP 559

3.7 sacurity 0150677 I033-06-2T FFF 53

F) Instalar herramienta ESP:

F.1 Abra cmdy ejecute: (en caso de que uno no funcione, intente lo siguiente).
e pipinstall esptool
e python -m pip install esptool

e pip2install esptool

mmand Prompt
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ommand Prompt

Reguireme progra
from

1\programs\

for esp I "wheel”
: reeds s B . : trin
r espto
tstring-4. i a-d .@ tool-4.5. yserial-3.5 reedsolo-1.

suario»

F.2 La memoria flash se borra:

esptool.py --chip esp32 --port COMX erase_flash (Reemplace la X con el niimero de puerto COM)

(mientras mantiene presionado el botdn de inicio, no es posible en el KMI)

& Device Manager — [m] X
File Action View Help
= | 5| Hi

s Disk drives
& Display adapters
i Firmware
vy Human Interface Devices
—‘I\" Imaging devices
E= Keyboards
1 Memory technology devices
{§ Mice and other painting devices
[ Maonitors
Metwork adapters
E7 Other devices
v [l Ports (COM & LPT)
ﬁ Serie estandar sobre el vinculo Bluetooth (COM3)
ﬁ Serie estandar sobre el vinculo Bluetooth (COM4)
% Serie estandar sobre el vinculo Bluetooth (COM3)

1_Serie estandar sobre el vinculo Bluetooth (COME)
ﬁ USB-SERIAL CH340 (COM3)
[ Print queues
I Processors
B Security devices
B Software components
§ Software devices

i Sound, video and game controllers

S Storage controllers
E3 System devices

L E ]
B |Iniverzal Serial Rus controllers

iy

Abra el administrador de dispositivos y reemplace la x con el nUmero de puerto com
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ommand Prompt

Preparing metad

Collecting py
ched p

Collecting r

|ar:l'1r|g reed
Reguiremen . wsers\usuario\appdata\ \ \python\python31e\li
from c
Requiremen B in c ers\usuario\appdata‘\loc ogra ython\python3ie\1i
from e B->e )
Requir

‘wheel® is n
bitstring,

F.5 Descargue el ultimo firmware de micropython para ESP32 desde:

https://micropython.org/download/esp32/

L @ micropythonang/downloadespads

Features:

Source an GitH IER

More Infa: Vot

The folloen ailfy irmware for ESP3Z2-hascd boands withoul cxtemal SPIRARM.

This firmreare i compiied using ESP-IOF vd_x. Some okder releases ane also provided that are compiled with ESP-

DF vax.

Installation instructions
"'C; ram your boand using the esptoc .oy program, found here

1 you are putting MICroPython on your board for the fist ime then you should first erase the entire flash using

¥ chip espd2

From than on program the

Firmware

Relea

iites] [latest)
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F.4 Copio el comando para flashear el firmware, cambiando el puerto com de linux a COMX

L 3 @ micropythanang dewnlaad/espd2s
Venaor: £l
Features: Gl
Souree an Gitk
Mare Info: b

Th 1ol o I daly nmwane for E5P32-0as0d baands without cxtemal SPIRAM.

This firmeare s complied using ESP-I0F 4. Some okder releases ane also provided that are complled with ESP-
IDF w2

Installation instructions

Program your biand using the esptocl.oy pragram, Saund nere.

1T you are putting MicroPython on your board for the first ime than you should first erase the entine flash using

Firmware

Releases
2022-08-18) _bin | 2If] [ map] [Rekase notes] (latest)

Firmware (Compiled with IDF 3.x)

Releases

El firmware en este caso se guarda en la carpeta de descarga.

4 |4 This PC Datos (Dz) Backup Usuario Downloads

Mame N Date modified
Cluick access
Desktop Today (4)
l Telegram Desktop 3/10/2023 10:52 AM File folder
. esp32-20220618-v1.19.1.bin 3 41 AM BIM File
' PCB MCU ESP32 V1.3_logo INET 3 A Proteus Project
e python-3.11.2-amdé4 3 3 10:50 AM Application

Downloads
Documents
Pictures
Calidad de aire

Yesterday (5)

COsas persclnalr—.-s

F.5 Abrir una terminal en descargas

F.6 Copie el nombre del firmware descargado

4 4 This PC Datos (Dx) Backup Usuario Downloads

Mame - Date modified
Cuick access
Desktop Today (4)
l Telegram Desktop : 0:52 AN File folder
B esp32-20220618-v1.19.1.bin 310/ Y BIM File
' PCB MCU ESP32 V1.3_logo INET 310/, A Proteus Project
¥ python-3.11.2-amdb4 3 3 10:50 AM Application

Downloads
Documents
Pictures

Calidad de aire

Yesterday (5)

Co5sas FIEFSEIFIEIES




F.7 Coloque el comando copiado, colocando el puerto COM correspondiente y cambiando el nombre de
firmware descargado. En este caso el comando permanece:

esptool.py --chip esp32 --port COMX --baud 460800 write_flash -z 0x1000 esp32-20220618-v1.19.1.bin

Windows Powershell
Copyright (C) Microsoft Corporation. All rights reserved.

Try the new cross-platform PowerShell https://aka.ms/pscores

PS D:\Backup\Usuario\Downloads> esptool.py esp32 4608080 write_flash 9x1080 esp32—20220618—vl‘19.l.bim

Entonces ejecutar

F.8 Comando ejecutado, KMI con micropython firmware cargado

B Windows PowerShell @

Windows PowerShell
Copyright (C) Microsoft Corporation. All rights reserved.

Try the new cross-platform PowerShell https://aka.ms/pscoreé

PS D:\Backup\Usuario\Downloads> esptool.py esp32 u60808 write_flash 9x1808 esp32-20220618-v1.19.1.bin
esptool.py vi.5.1

Serial port COM9

Connecting

Chip is ESP32-DOWDQ6-V3 (revision v3.8)

Features: WiFi, BT, Dual Core, 2u46MHz, VRef calibration in efuse, Coding Scheme None

Crystal is UBMHz

MAC: c8:c9:a3:f9:b1:90

Uploading stub...

Running stub...

Stub running...

Changing baud rate to uU68388

Changed.

Configuring flash size...

Flash will be erased from 6x00001860 to @x8017efff...

Compressed 1568976 bytes to 1829132...

Wrote 15608976 bytes (1829132 compressed) at 8x08001800 in 23.4 seconds (effective 534.3 kbit/s)...
Hash of data verified.

Leaving. ..
Hard resetting via RTS pin...
PS D:\Backup\Usuario\Downloads>

G) Pasos para programar en micropython:

G.1 Ir ala siguiente url: codewith.mu

c & codewith.mu B = % = 0O s H

@ Download About Tutarials Howe to..? Discuss Developers Language

Code with Mu: a simple Python editor for beginner programmers.

—

P (+) &) &) P E2) M) (@) Q)(C)(d)2)(O

Mode New Load Save Runy, Debug REPL Plotter Zoom-in  Zeom-out  Theme Check Help Quit
hello.py * 2

1 print("Hello from Mul"})

2 |
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G.2 Vaya a Descargar y descargue la version para Windows.

@ Download Mu X +

& c & codewith.mu/en/download

@ Download  About  Tutorials — Howto.?  Discuss  Developers  Language-

Download Mu

The simplest and easiest way to get Mu is via the official installer for Wincows or Mac 05X (we no longer support 32hit Windows). We also have an experimental Applmage for Linux

users running on Intel based hardware.

The current recommended version is Mu 1.2.0. We advise people to update to this version via the links for each supported operating system. All previous beta versions of Mu can be

downloaded from here

- Windows Installer

M Instructions

G.3 Abra el instalador, acepte los términos y presione instalar.

ﬂ hu Editor 1,2.0 Setup

Please read the ™u Editor 1.2.0 License
Agreement

GNU GENERAL PUBLIC
LICENSE
Version 3. 29 June 2007

Copyright [C] 2007 Free Software
Foundation, Inc. <http:jfisf.orgf>
Everyone is permitted to copy and
distribute werbatim copies

of this license document, but changing it
is not allowed.

Preamble

[/]1 accept the terms in the License Agreemant

$ | Install Cancel

27



G.4 Abra el programa Mu, tardard un tiempo en ejecutarse.

Mu: a Python editor

https://codewith.mu/

G.5 Seleccionar para programar con ESP MicroPython

@ nu1.2.0 - sin titulo -
—
—) I
rP(+) &) &) (> BE M@ Q)e¢) &) (=200
Modo Muevo  Cargar  Guardar | Ejecutar Archivos REPL  Trazador | Acercar  Alejar Tema Comprobar  Tidy Ayuda Salir
sin titulo x
1 # Escribe tu cdédigo aqui @ seleccionar mota 7 %
2

Selecciona el modo deseada y luega haz clic en "OK". Sina, haz clic en "Cancelar”,

BEC microtbit
Escribe MicraPython para BEC micro:hit,

CircuitPythan
Yérite code for boards running CircuitPython,
[ESP MicraPython
i\Write MicroPython on ESPE266/ESP32 boards.
v Lego MicraPython
Write MicroPythan directly on Lege Spike devices,
Pyboard MicraPython
Use MicroPython on the Pyboard line of boards,

o Pygarne Zero
@'&-\@ Crea juegos can Pygame Zera, -

Cambia &l modo en cualquisr momento hacienda dic en el bakén "Moda” con el loga de Mu,

Ok Cancel

G.6 Una vez abierto el programa, vaya a la opcion de carga.

@ MU 1.2.0 - sin titulo

r L&) (BB M QQG) () (Z(2)O

Mada MUEvo  Cargar  Guardar | Ejecutar Archivos REPL  Trazador | Acercar  Alejar Tema Comprobar  Tidy Ayuda Salir

sintiun M
1 # Escribe tu cédigo aqui :-)
2
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G.7 Abra el archivo python con el programa

@ Dpen file

i

= v A = Escritorio » Manual v & 2 Buscar en Manual
Organizar = Mueva carpeta = -
#F Accesorapido
[ Escritorio -
; Descargas -
= Docurmentos o = -
sonidao| Tipo: Python File
= Imagenes # Tamnafio: 2,01 KB

Fecha de modificacian 1332023 10:33

kdanual
& Onelrive - Personal
[ Este equipa

o F Red

Mormbre de archivo: | sonidas_neapixel s My Moy Moher Yoess Vbt VP

Abrir

Cancelar

G.8 Conecte el esp32.

G.9 Haga clic en ejecutar

® Mu 1.2.0 - sonidos_neapixel.py

P+ X > BE =M QNQIC) () (=) 2O

Moda Muevo  Cargar  Guardar | Ejecutar Archivos  REPL  Trazador = Acercar  Alejar Tema Comprobar — Tidy Ayuda Salir
sin titula M sonidos_neopixel.py x
1 import machine
2 import time
s dmport neopixel
4 from time +import sleep
s # Definir el numero del pin donde estd conectado el zumbador
& buzzer_pin = machine.Pin{1l4, machine.Pin.0UT)
7 # Definir las notas de la melodia
s melodia = [IIG4II’ "C5", "E5", "D5", "CB", IIB4II’ IICSII’ IIB4II]
9

10 # Definir las duraciones de cada nota
11 duraciones = [200, 200, 200, 400, 200, 200, 200, 400]

13 # Configurar el PWM para el zumbador
14 buzzer_pwm = machine.PwM{buzzer_pin)

15 # Reproducir la melodia cuatro veces

17 for j in range(4):
1 for i. nota in enumerate(melodia):

G.9 Ahora el programa se ejecuta en tiempo real en el ESP32
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